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Using This Book

Audience

SAS Energy Distribution Optimization is designed for the following users:
Grid Engineers responsible for creating and scheduling runs for optimization.
Operators responsible for viewing and implementing the optimized plans.

Report Viewers or Managers responsible for viewing and analyzing the forecasted
results.

Administrators responsible for data management and application environment setup.

This document explains the tasks that you can perform by using the SAS Energy
Distribution Optimization user interface, as per the assigned user roles. These roles
determine the tabs and type of records that are visible within the user interface. For
more information about working with users and groups, see SAS Energy Distribution
Optimization: Administrator’s Guide.

Prerequisites

Here are the prerequisites for using SAS Energy Distribution Optimization:
A user ID and password for logging on.
A supported browser installed on your desktop.

If you have any questions whether you are ready to use SAS Energy Distribution
Optimization, contact your system administrator.
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Accessibility Notice

For more information about the accessibility of this product, see accessibility Features

of SAS Energy Distribution Optimization at support.sas.com.
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Recommended Reading

SAS Energy Distribution Optimization is supported by the following documents:
SAS Energy Distribution Optimization: Administrator’s Guide
SAS/OR 13.1 User's Guide: Mathematical Programming

For a complete list of SAS books, go to support.sas.com/bookstore. If you have
questions about which titles you need, please contact a SAS Book Sales
Representative:

SAS Books

SAS Campus Drive

Cary, NC 27513-2414

Phone: 1-800-727-3228

Fax: 1-919-677-8166

E-mail: sasbook@sas.com

Web address: support.sas.com/bookstore
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Introduction to SAS Energy Distribution
Optimization

What Is SAS Energy Distribution Optimization? 1
Features Of SAS Energy Distribution Optimization 2
How Does SAS Energy Distribution Optimization Work? 3

What Is SAS Energy Distribution
Optimization?

SAS Energy Distribution Optimization enables electric distribution companies to
optimize the performance of their electric distribution networks through advanced
analytical methods such as loss minimization and conservation voltage reduction
(CVR). It uses the smart grid technology to collect data from passive or active devices
located in substations and along distribution feeders to forecast network performance.
This data provides recommendations for the optimal switching of devices such as
voltage regulators, transformer load tap changers, static volt-ampere reactive (VAR)
compensators, capacitors, and synchronous condensers or generators. The optimal
device settings reduce transmission and distribution losses, minimize electricity
consumption, improve voltage profiles, conserve energy, and manage peak load
through voltage reduction.

The optimization results help operators, engineers, and managers of the electric
distribution companies to minimize network operating costs and reduce demand without
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violating regulatory or industry limits for consumers. It minimizes the cost of energy and
facilitates the introduction of new technologies, such as wind power, solar power,
storage and micro-generation technologies.

Features Of SAS Energy Distribution
Optimization

SAS Energy Distribution Optimization is designed for the operations sector of the
electric utilities industry and for operators of institutional electric distribution systems.

Following are the key features of SAS Energy Distribution Optimization:

Uses energy forecasts to develop an hourly load curve for each utility network that is
applied to individual network loads. SAS Energy Distribution Optimization also
contains features to modify the existing settings of the electric load based on the
current environmental factors affecting the electric demand of the utility.

Recommends the accurate tap settings for voltage regulators that are located in the
substations and along distribution feeders to regulate the power flow. The
recommended settings can minimize losses and increase the electricity savings of
the substation.

Recommends the optimal voltage levels required for each device to operate the
distribution system and minimize the electricity demand. The suggested voltage
levels help to reduce electricity consumption and to minimize the need of rolling
blackouts during critical peak periods.

Provides reactive power support for the transmission and distribution bus and
increases efficiency by reducing system loss caused by reactive power.

Displays automated reports of the optimization results using interactive graphs in the
dashboard.
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How Does SAS Energy Distribution
Optimization Work?

SAS Energy Distribution Optimization uses heuristic algorithms to determine the optimal
solution for optimizing the voltage and VAR requirements on the electric distribution
networks. You can optimize the operations of a distribution network by managing the
voltage and capacitance levels. The CVR methodology helps reduce the real and
reactive power while loss minimization helps to achieve the lowest level of losses
without violating any voltage constraints.

In CVR mode, the energy supplied by the source bus is reduced by lowering the
demand of the network. To reduce the demand of the network, voltage regulators are
adjusted to their lowest tap settings and capacitor banks are set to either on or off so
that the lowest network voltage is achieved without violating regulatory limits. The
algorithm searches through each regulator and capacitor, varying their settings until the
optimal solution is found.

In loss minimization mode, losses are minimized by adjusting the voltage and
capacitance of the distribution network to achieve the highest possible voltage level,
without violating regulatory limits. The algorithm first calculates the voltage regulator tap
setting needed to achieve a voltage level of 1.05 per unit and runs the initial load flow. It
then adjusts the capacitor and regulator tap settings until the optimal loss level is
achieved. The premise of the loss minimization algorithm is that the bulk of the network
load is constant power and raising the voltage reduces the current, thereby lowering
losses. The impact that voltage has on losses is greatly influenced by the zero-inflated
poisson (ZIP) model used in representing customer load.
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Managing Access to SAS Energy
Distribution Optimization

Roles and Capabilities 5
Log On to SAS Energy Distribution Optimization 7
Log Off from SAS Energy Distribution Optimization 7

Log On to SAS Energy Distribution Optimization
from the SAS Visual Analytics Hub 8

Roles and Capabilities

Depending on the user roles, SAS Energy Distribution Optimization users have a
defined set of tasks that they are authorized to perform for the user group to which they
belong. Roles are mapped to capabilities that define the operations a user can perform.
SAS Energy Distribution Optimization supports the following user groups:

Grid Engineers, who have complete control over the user interface (Ul) to create and
manage runs for optimization.

Operators, who can analyze and implement the suggested optimized results.

Report Viewers or Managers, who can view and analyze the suggested optimized
results.
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Administrators, who are responsible for data management and application
environment setup. Administrators also define new user roles to access the

application and specify the capabilities to perform.

The following table provides information about the capabilities for the user roles that are
defined in SAS Energy Distribution Optimization. The four columns on the right indicate
the type of access authorization that is required for performing the tasks that are listed

on the left.

Table 2.1 User Roles and Capabilities

Capabilities

Create
LookAhead Run

Delete
LookAhead Run

Schedule
LookAhead Run

View LookAhead
Run Results

Modify
Operations Plan

Publish
Operations Plan

Implement
Operations Plan

Create
Optimization
Reports

View
Optimization
Reports

Grid Engineer

Yes

No

Yes

Yes

Yes

Yes

No

No

No

Operator

No

No

No

No

No

No

Yes

No

No

Report Viewer
or Manager

No

No

No

No

No

No

No

Yes

Yes

Administrator

No

Yes

No

No

No

No

No

No

No
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Report Viewer
Capabilities Grid Engineer Operator or Manager Administrator
Delete No No No Yes
Optimization
Reports

Log On to SAS Energy Distribution
Optimization

Administrators register the necessary users in the metadata server and group the users
based on their privileges. You can use the SAS Energy Distribution Optimization
interface only if you have appropriate access permissions.

To access the SAS Energy Distribution Optimization log on window, paste the address
that your administrator has provided in your web browser. For example, you might enter
http://serverl23.domain.com:9080/
SASEnergyDistributionOptimization/ or a similar address.

To log on, enter your user ID and password, and click Log On. The main application
window of SAS Energy Distribution Optimization appears.

Note: Your password is case-sensitive. Your user ID might be case-sensitive,
depending on the operating system that is used to host the web application server. If
you need assistance, contact your system administrator.

Log Off from SAS Energy Distribution
Optimization

To log off from SAS Energy Distribution Optimization, on the application bar, click Log
Off.
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If you lose your connection to SAS Energy Distribution Optimization (for example, your
session times out), you must begin again at the point where you last saved your work.

By default, if there is no activity for 25 minutes, SAS Energy Distribution Optimization
prompts you to either continue the session or log off from the application. If you do not
select either of the options within a certain time (the default is 5 minutes), SAS Energy
Distribution Optimization directs you to a window displaying the Return to Application
button that enables you to access the application without logging on again. Further, if
there is no activity for the next 12 hours, SAS Energy Distribution Optimization
automatically logs you off and displays the Log On window.

Your system administrator can change the inactivity period and the countdown period.
As a best practice, save your work frequently.

Log On to SAS Energy Distribution
Optimization from the SAS Visual
Analytics Hub

You can connect to SAS Energy Distribution Optimization from the SAS Visual Analytics
Hub if the SAS Visual Analytics server (SaSserver12) is active.

To access the SAS Visual Analytics Hub log on window, paste the address that your
administrator has provided in your web browser. For example, you might enter
http://server.host.com/SASVisualAnalyticsHub/ or a similar address.

1 Enter your user ID and password, and click Log On. The main page appears.

2 From the Common Actions section, select Open EDO Workspace. The main
application window of SAS Energy Distribution Optimization appears.

Alternatively, you can select the workspace from the g |- or the More Actions list.
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SAS Energy Distribution Optimization
User Interface

The SAS Energy Distribution Optimization interface helps you optimize the electric
substation banks and distribution feeders using loss minimization and conservation
voltage reduction (CVR) methods. It also helps you generate reports to analyze the
performance of the substation banks.

Note: This user's guide discusses tasks that you might not be able to perform,
depending on your user role. For more information about the different user roles and
capabilities in SAS Energy Distribution Optimization, see “Roles and Capabilities” on
page 5.

Components of the User Interface

The SAS Energy Distribution Optimization user interface (Ul) is divided into various
parts that enable you to manage your data selections.
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The following image shows the SAS Energy Distribution Optimization Ul and its primary
components.

Figure 3.1 SAS Energy Distribution Optimization User Interface

2 5 6

SAS ® Energy Distribution Optimization - - gsas

I File Help A¢ Setup  [® Analysis [ Operations Reporting Log Off |
[R Runc Run C (50f5)  Search: (none) » || save search| |
[ Run Instances | * @< =B [open [+
Hame 4 Description =~ |+ Run Details
CVR for 123 node networks Variable load forecasts ame: CVR for 123 node networks
I CVR for 13 node networks Variable load forecasts Description: Variable load forecasts
L on 123 node networks Variable load forecasts i Networks SRR A%
3 — 'l LM on 13 node networks Variable load forecasts H Turtie 123 — 7
funpredefined ) Epson 123
4 — = View ¥
I
8
1 Application Bar
The application bar is located at the top of the application window. The application
bar contains the File menu, the Help menu, the workspace buttons, and the Log Off
option.
2 Workspace Bar
The workspace bar consists of the Setup, Analysis, Operations, and Reporting
workspace buttons.
3 Categories Pane
The categories pane contains the category view buttons that switch between two
categories of the workspace.
4 Tile Pane

The tile pane contains the summary of items that are open in the current workspace.
It manages the layout within a workspace. When you open an item, you can add it to
the tile pane as a minimized item or open it and work with it in the layout. A layout is
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simply a collection of one or more open items in a specific order or arrangement in
the tile pane.

Click % to close the item’s tile.
Click 4l to return to the previously displayed category pane.
Click @ to display the most recently viewed detail tile.

Click View and select Close All to close all open items.

Click View and select Show All to open the tiles for all of the minimized items in the
tile pane.

Click =% at the far right of the tile pane to maximize the display of the currently
opened objects.

5 Toolbar

All views contain a toolbar. The toolbar contains icons that you can use to perform
frequent tasks.

6 Object Navigator

The object navigator displays a list of objects that are defined for the type of object
that you have selected in the category pane.

7 Details Pane
The details pane contains the descriptions of the optimization attributes.
8 Status Bar

The status bar displays the name of the user and other status messages.

Time Zones

You can access the Ul of SAS Energy Distribution Optimization by using a browser. The
optimization date and time that you see on the Ul is the time zone of the browser. If the
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server and the browser are located in different time zones, the data is converted to the
browser’s locale and is displayed based on the browser’s time zone.

Note: The optimization result reports are generated based on the server’s time zone.

Interface Help

Help Menu

The Help menu is located on the application bar. Use the Help menu to access the
following information about SAS Energy Distribution Optimization:

SAS on the Web: Provides links to SAS Customer Support, SAS Training, and the
SAS home page.

About SAS Energy Distribution Optimization: Displays the version number, copyright
details, and other information about SAS Energy Distribution Optimization.

User’s Guide: Opens the PDF file of the SAS Energy Distribution Optimization:
User’s Guide in a new window.

How To: Provides links to the Help topics identified for the currently used page.

Embedded User Assistance

Embedded User Assistance is a help component that displays detailed information
about corresponding field or interface elements. Click @ to view the information.
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Search Items

Search Text

The Search field enables you to search the name of plans and optimization results
listed in the workspace.

Save Search Item

The Save Search option enables you to save the search items for future reference.
When your click Save Search, the Save Search window appears and details of the
search criteria are saved. To view or delete the saved search criteria, select Save
Search » Manage Saved Searches.

Additional Search Options

In the Analysis workspace, you can filter banks that are in a specific optimization range
by selecting the Yicon next to the Search field. Enter the values by using the slider
scale or by entering the specific values in the appropriate slider box. For example, if you
want to view substation banks whose electricity savings are between 726 watts and
4,000 watts, then select that range from the Savings (Watts) field. The substation
banks with electricity savings in that range are displayed.
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Display 3.1 Search Filter

'y ™y
Y@ )
X 1=
¥ Savings (Watts)
0 5121
=% A 5~
726 |-4,000 |

- Estimated Watts / Action
- Estimated Actions

> MNumber of Devices

Setting Preferences

Preferences provide a way for you to customize the user interface. Preferences for each
user are stored in metadata and retained if your deployment is migrated or reconfigured.
To open the Preferences window, select File » Preferences. There are two general
categories of preferences: global preferences and SAS Energy Distribution Optimization
preferences. The SAS Energy Distribution Optimization preferences contain both
general and advanced run configuration options.

Set Global Preferences

Global preferences apply to all SAS web applications that are displayed with the Adobe
Flash Player. When you set a global preference, it applies only to the user that you are
logged on as.

To set global preferences, select Global Preferences. The following global preferences
are available:

User locale
specifies the geographic region whose language and conventions are used in the
applications. This setting might also apply to some SAS web applications that are
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not displayed with the Adobe Flash Player. Locale changes take effect after you log
off and log back on.

Theme
specifies the collection of colors, graphics, and fonts that appear in the applications.
The theme that is set as the default theme is displayed in parentheses. Your site
administrator can change the default theme. A theme change might take a few
seconds to apply if many items and features are open in the application.

Invert application colors
inverts all of the colors in the application window, including both text and graphical
elements. You can also temporarily invert or revert the colors for an individual
application session by pressing Ctrl+~.

Override settings for focus indicator
controls the appearance of the highlighting that surrounds the currently selected field
in the SAS Energy Distribution Optimization interface.

Reset
controls the display of warning and confirmation messages.

Note: Whenever necessary, click Reset to Defaults to restore the original default
settings and values.

SAS Energy Distribution Optimization General
Preferences

SAS Energy Distribution Optimization general preferences apply to SAS Energy
Distribution Optimization only.

Open application using this workspace
controls which workspace is displayed by default when you log on to SAS Energy
Distribution Optimization.

Workspace bar
controls whether the toolbar for the workspace displays icons, text labels, or both.
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Advanced Run Configuration Options

Note: Knowledge of SAS/OR and the load flow model is required to edit the advanced
run configuration options. These options are important for the stability of the SAS
Energy Distribution Optimization application. It is recommended that you contact SAS
Technical Support before editing these options.

Use the advanced run configuration options to edit the predefined configuration settings
of the runs. These settings will be applied to all the run configurations when they are
created. You can choose to edit the configuration settings for a particular run by
selecting the Show Advance Options for Run Configuration check box. The
Advanced Options tab in the Create Configuration window or in the edit window of the
run is activated.

The advanced run configuration options are referenced from the SAS/OR nonlinear
programming (NLP) solver. For more information about the NLP solver, see the
SAS/OR® 13.1 User's Guide: Mathematical Programming, which is located at nhttp://
support.sas.com/documentation/cdl/en/ormpug/66851/PDF/default/ormpug.pdf.

The advanced run configuration options includes the following fields. These fields are
activated when you select the Override Defaults check box.

Algorithm
indicates the algorithm that is used to solve the problem. It consist of the following
values:

Interior Point: The interior point algorithm to produce the solution data.
Active Set: The active set algorithm to produce the solution data.
Concurrent: The concurrent algorithm to run algorithms concurrently.

Local solver
specifies the maximum number of iterations. The value can be any integer between
1 and the largest 4-byte signed integer (2*31-1). The default value is 100.

Multiple-Start
defines the maximum number of starting points to be used for local optimization.
That is, there are less than N local optimization calls in the multistart algorithm. You


http://support.sas.com/documentation/cdl/en/ormpug/66851/PDF/default/ormpug.pdf
http://support.sas.com/documentation/cdl/en/ormpug/66851/PDF/default/ormpug.pdf
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can specify N to be any nonnegative integer. When N = 0, the algorithm uses the
default value of this option. In a shared memory computing environment, the default
value is 20. In a distributed computing environment, the default value is a number
proportional to the number of threads across all the grid nodes.

Optimization tolerance
specifies the optimality tolerance in [1E-9, 1E—4] for declaring the optimality. The
default value is 1E-6.

Optimization feasibility tolerance
specifies the feasibility tolerance in [1E-9, 1E—4] for determining the optimization
feasibility of a variable value. The default value is 1E—6.

Load flow tolerance
specifies the load flow tolerance in [1E-9, 1E—4] for declaring the load flow. The
default value is 1E-9.

Load flow feasibility tolerance
specifies the feasibility tolerance in [1E-9, 1E—4] for determining the load flow
feasibility of a variable value. The default value is 1E—6.

These settings are applied to all the run configurations that are created.
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Setting Up an Optimization Run

About Run Configurations
Types of Optimization
Forecast Criteria for Optimization

About the Setup Workspace
The Setup Workspace
View the Optimization Runs
View the Scheduled Run Instances
View Run Details

Working with the Setup Workspace
Create a Run
Edit a Run
Delete a Run
Schedule a Run for Optimization

About Run Configurations

A run configuration forecasts the performance of a network and its substation banks.

19
20
21

22
22
22
23
24

25
25
27
27
27

The forecast results help the grid engineers and operators initiate actions for optimizing
the transformer banks and distribution feeder devices in real time. These actions enable
the utility to minimize distribution losses, compensate the reactive power in the system,

maintain voltage, and reduce the demand during peak load periods.
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A run configuration consists of the network list of substation banks that need to be
optimized, the type of optimization method, the forecast criteria, and the optimization
schedule for the run. You can create a run configuration in the Setup workspace. For
more information, see “Create a Run” on page 25.

Display 4.1 Create Run Configuration

Create Configuration X

Name: *[Reedy Creek | Optimization type: | Loss minimization | v | @

Description: |Savings under Reedy Creek |

Forecast settings:
Select networks: #

l;@ j Standard Options | Advanced Options
v (W] Test = ®
b E. VARIABLE Percent load modification: E
v (=]l Group 1 _ (=]
v LI James 123 <||| | start date offset: E=
[] James 123 Bank #1 _
v V]Il Reedy Creek 12 L SEIE
[V] Reedy Creek 13 Bank #1 End time:
v ]I SAS Bank 13
[] sAS 12 Bank #1
[] sAS 12 Bank #2
v [ Group 2
v [ ]Il CaryEast13
[] cary East 12 Bank #1
v ] Cary West13 v

| oK || ScheduIeN-:w.r| || Cancel |

Types of Optimization

SAS Energy Distribution Optimization uses the loss minimization and conservation
voltage reduction (CVR) optimization methods. You can select these methods while
creating a run configuration.

The loss minimization method helps to minimize the distribution loss of electricity
between the time the electricity is generated in the utility-generating station and the
time it first reaches consumers. The results of the optimization display the optimal
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device settings to reduce transmission and distribution losses, and they suggest the
corrective actions required for the devices in the utility. For example, the results can
indicate an action to turn a capacitor bank device on or off or to display the optimal
tap settings required to regulate the load flow for voltage regulators and
transformers.

The CVR optimization method helps achieve demand reduction using voltage
reduction, without violating regulatory or industry limits for consumers when the
demand for electricity is high. The optimization results suggest the optimal device
settings for capacitors and regulators to minimize the electricity demand. For
example, the results can indicate the optimal voltage levels required on regulators to
reduce the demand for energy, thus enabling significant savings.

Forecast Criteria for Optimization

The forecasting feature in SAS Energy Distribution Optimization enables you to set the
date and time to start the forecasting while creating a run configuration in the Setup
workspace.

This feature also enables you to change the forecasted electric load percentage based
on the current electric demand in the utility. The values for the base load forecast are
provided by the utility in the form of an hourly load curve and the expected future peak
load. This information is based on the historical performance of the utility. Due to
various factors, there can be changes to the current load settings of the utility. For
example, if extremely hot or cold weather is expected over the next several days, the
electricity load requirement would vary. You can either increase or decrease the
forecast percentage for the electric load, depending on the expected electric demand of
the utility.
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About the Setup Workspace

The Setup Workspace

The Setup workspace enables you to create a run configuration and set an optimization
schedule for the run. It consists of the Run Configurations and Run Instances
categories, toolbar options, and the Run Details pane.

Here are the toolbar options that are available in the Setup workspace:

Table 4.1 Toolbar Icons

Toolbar Icons Action Description

[* Create a configuration Creates a run configuration for
optimization. For more information,
see “Create a Run” on page 25.

m Delete Deletes the run configuration that is
selected in the category list.

%] Refresh Updates the category view with the
latest data.

II
-

Sort Sorts the rows in the category
according to the values of the
columns.

] Manage Columns Selects the columns to be displayed
in the category and customizes the
view.

View the Optimization Runs

The Run Configurations category displays the list of runs created for optimization. You
can create, edit, delete, and schedule these run configurations for optimization.
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View the Scheduled Run Instances

The Run Instances category displays the status of the runs that are scheduled for
optimization. The runs are grouped in a hierarchy based on the optimization schedule.
The main folder contains the runs for all time periods. Expand this folder to view the
scheduling status of each substation bank in the run. The subfolder contain runs that
are scheduled at the same date and time.

Display 4.2 Run Instances Category

File Help M Setup [% Analysis [Z]] Operations Reporting

[ Run Configurations | Run Instances (20 of 20) Search: (none)

ERinsasces | @ ¢

Name Description Status  Optimization Type Run Details

» [l CVR for 13 node networks ‘ariable load forecasts @ CVR Mame: CVR for 13 node networks
"‘. CVR for 123 node networks Variable load forecasts @ CVR Description: Variable load forecasts
» [ LM on 13 node networks Variable load forecasts © Loss minimization |dentifier Group ID: 3

> L1 on 123 node networks ariable load forecasts @ Loss minimization Start date: Thursday, March 20, 2014

Starttime: 0630 PM

End date: Thursday, March 20, 2014
Endtime: 07:33 FM

Status: Completed

Type: CVR

Starttime: 0830 FPM

Endtime: 02:30 AM

: Percentload modification: 0

" Start date offset 1

: | Cancel

Here are the details of the scheduled list of runs:

Name of the run. Expand the run folder to view the status of each instance when the
run was scheduled.

Description of the run.

Status of the run that is scheduled for optimization. The different statuses are:

@® indicates that the run is being scheduled for optimization.
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@ indicates that the optimization is complete. The optimized results of the
successful runs are displayed in the Analysis workspace.

® indicates that the run is not scheduled for optimization and the results will not be
displayed. You can right-click the run instance to view the error log for that run.

& indicates that some of the substation banks in the run are not scheduled for
optimization. The results of the failed banks are not displayed.

@ indicates that the scheduling process of the optimization was canceled by the grid
engineer.

X indicates that the run is scheduled for a recurring or future date and time.

Optimization Type indicates the type of optimization method selected while creating

the run configuration—loss minimization or CVR.

View Run Details

The Run Details pane displays the additional properties for the selected run. Some of
the properties listed in this pane are the same as those in the Run Instances category.
For more information, see “View the Scheduled Run Instances” on page 23. Here are
the properties that are also available in the Run Details pane:

Identifier Group ID indicates the internal IDs of the data associated with each
optimized run.

Start date and Start time indicate the date and time at which the optimization
schedule started.

End date and End time indicate the date and time at which the optimization
schedule stopped.

Start date offset indicates the start date for the forecast.

Percent load modification indicates the modified percentage value of the forecast
electric load.

Forecast Start time and Forecast End time indicate the start and end times for the

forecast.

You can click Cancel to stop the scheduling process of the optimization.
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Working with the Setup Workspace

Create a Run

A run enables you to define the criteria for optimization.

To create a run:

1

In the Run Configurations category, click [*. The Create Configuration window
appears.

Enter a unique name for the run in the Name field. The name of a run is limited to 50
characters and cannot containthe ! % * . & =\/|"; > and < characters.

Enter the description in the Description field. The description size is limited to 255
characters and cannot containthe ! % * . & =\/|"; > and < characters.

Expand the Select networks list, and select the required networks and substation
banks. You can also use the /@ box to filter the network list.

A check mark appears next to the selected substation banks.

From the Optimization type list, select the optimization method for the run:

Select Loss Minimization to view the optimal device settings for minimizing the
electricity distribution loss between the utility and consumers.

Select CVR to view the optimal voltage levels of the utilities for minimizing the
electricity demand.

For more information, see “Types of Optimization” on page 20.
In the Forecast settings section,
Click Standard Options to specify the following forecast criteria for the run:

Percent load modification indicates the percentage value to modify the
forecast electric load based on the current electric demand in the utility.
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Note: The percentage value should be between -50 and 50.

Start date offset indicates the number of days to set the forecast start date
after the run is scheduled. For example, a value of 0 indicates that the run is
forecasted on the scheduled date while a value of 1 indicates that the run is
forecasted a day after the scheduled date.

Note: The value should be between -180 and 180 days.

Start time and End time indicate the start and end times for forecasting the
optimization.

Click Advanced Options to edit the predefined configuration settings of the run.
A confirmation message is displayed. For more information, see “ Advanced Run
Configuration Options” on page 17.

Note: The Advanced Options tab is displayed only if the Show Advance
Options for Run Configuration check box is selected in the Preferences
Advanced Run Configuration Options section.

7 You can choose to save or schedule a time for the run to generate the optimization
results once, at recurring intervals, or at a future date. A warning message is
displayed if the scheduled date and time of the run is set prior to the current date.

Click OK to save the run without scheduling it for optimization. The new run is
listed in the Run Configurations category.

Select Schedule Now to schedule the run immediately.

Select Schedule Later to schedule the run at a later date. In the Schedule
window, select the start date and time.

Select Schedule Recurrence to schedule the run at a regular time during the
selected time period.

The status of the runs that are scheduled for optimization are displayed in the
Run Instances category.

To exit out of the Configuration window without saving or scheduling the run, click
Cancel.
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Edit a Run

1

Double-click the run in the Run Configurations category. The window containing the
run configuration details appears.

For more information about the configuration fields, see “Create a Run” on page 25.
Edit the required fields in the run and click Save.

Note: A £ icon indicates that the run is being edited by another user. You can edit
the details and set a schedule for the run, but you cannot save the run.

Delete a Run

1

Select a run from the Run Configurations or Run Instances category and click T on
the toolbar. The Confirm Delete window appears.

Click Yes to delete the run configuration or run instance. A progress bar indicating
that the delete process is in progress is displayed.

Note: You cannot delete a run instance before the forecast date when there is a
published plan in the Analysis workspace. If you try, an error message is displayed.
You need to recall the published plan and then click .

Schedule a Run for Optimization

You can schedule a date and time for the run to generate the results once, at recurring
intervals, or at a future date. The status of the scheduled run is displayed in the Run
Instances category. You can set a schedule while creating, modifying, or viewing the
run.

To schedule a new run, select the schedule options in the Create Configuration
window. For more information about scheduling a run when a new run is created,
see “Create a Run” on page 25.
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To schedule a run while editing, select the schedule options in the Run Configuration
window.

To schedule a predefined run, select the run and the schedule options in the Run
Details pane of the Run Configurations window.

Note: If you want to cancel the schedule process, select the run and click Cancel in
the Run Details pane of the Run Instances window.
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Analyzing the Optimized Plan

What Is a Plan?
Analyzing the Optimized Plan Results
Updating the Interval Settings

About the Analysis Workspace
The Analysis Workspace
Analyze the Optimized Plan Results at Each Interval
Analyze the Optimized Plan Result Summary

Working with the Analysis Workspace
Select a Plan for Analysis
Add Comments to Plans
Update the Optimized Plan Results
Publish the Optimization Plan Results

What Is a Plan?

The optimization results of a run that is scheduled through the Setup workspace are
displayed as a plan in the Analysis workspace. The results of the plan are displayed

29
30
30

31
31
31
35

38
38
39
39
40

based on the selections that you made while creating a run configuration. You can view

the optimized plan results in a grid and graph format. A plan contains the following:
= List of optimized substation banks

®  |Load forecast for a selected interval



30 Chapter 5 / Analyzing the Optimized Plan

Power savings

Number of estimated actions to be taken on the associated devices to minimize
losses

Estimated savings for each preventive action taken
Number of devices associated with the substation bank

Note: For ad hoc analysis of the plan, see the SAS Energy Distribution Optimization:
Administrator’s Guide to understand the output data tables.

Analyzing the Optimized Plan Results

The optimization results are displayed according to the schedule or interval that was
defined while creating the plan. The forecasted information helps you understand the
performance of the substation banks in a network. The loss minimization optimization
method displays the optimal device settings to reduce electricity losses, and the CVR
optimization method displays the optimal voltage settings to reduce electricity demand.
You can also view the detailed results of the power savings, demand reduction, and
estimated switching actions for each interval. These results are later published to the
operator for implementation in the Operations workspace.

Note: An error ® might be displayed for those substation banks whose network was
reloaded after the optimization was run. You need to remove the bank from the plan and
update the interval settings. If the plan is published, recall the plan before updating the
settings.

Updating the Interval Settings

Depending on the analysis, you can make changes to the results by selecting the banks
that display the best optimized results and update the interval of the plan with these
results. For example, you can select the banks with the maximum electric savings and
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the minimum remedial actions (loss minimization) or you can select banks with a large
reduction in demand and minimal remedial actions (CVR). Banks that do not have
savings or contain errors in any of the intervals appear disabled.

For loss minimization, you can select the required banks at each interval and then
update the interval with the new settings. The load flow for the remaining intervals is run
based on the new settings.

Note: Sometimes the new settings might produce an under— or overvoltage condition
or some other error while forecasting the load for future intervals. An error ® is
indicated and the bank cannot be included in that interval. To clear the error, change the
selection of the bank in a previous interval and run the load flow again. If the error is still
displayed, you need to remove the bank from the plan.

For CVR, when a bank is added in one of the intervals, it is subsequently included in the
remaining intervals. To remove the bank from the plan, you need to select the interval in
which the bank was added, remove the bank, and then update the interval settings.

For more information, see “Update the Optimized Plan Results” on page 39.

About the Analysis Workspace

The Analysis Workspace

The Analysis workspace displays the forecasted optimization results and the
appropriate actions to be taken to minimize losses and reduce demand. It consists of
the Intervals and Summary Schedule tabs; the toolbar options; and the Summary,
Device Settings, and Comments tabs.

Analyze the Optimized Plan Results at Each
Interval

The optimization results are displayed according to the schedule that you defined while
creating the plan. The forecasted information helps you understand the performance of
the substation banks in a network. The loss minimization optimization method displays
the optimal device settings to reduce electricity losses, and the CVR optimization



32 Chapter 5 / Analyzing the Optimized Plan

method displays the optimal voltage settings to reduce electricity demand. You can also
view the detailed results of the power savings, demand reduction, and estimated
switching actions for each interval. These results are later published to the operator for
implementation in the Operations workspace.

The Intervals tab displays the optimization results of the substation banks at each
interval. The interval is set based on the time scheduled for optimization while the plan
was created. For better analysis, the optimized data is displayed in a grid and graph
format. Depending on the sorting order of the table columns, the graph display also
changes.

Select an interval from the Interval list. The optimization results of the substation banks
in that interval are displayed as follows:

Table 5.1 Loss Minimization Optimization Results at Each Interval

Field Description

Select Selects the banks to be included for an
interval.

Status Displays the optimization status of the banks

in the plan at each interval. The status
changes when intervals are updated or
networks containing the banks are reloaded.

@ indicates that the optimization results
are displaying without errors.

(® indicates a failure to produce
optimization results for the next interval.
The recommended settings might have
resulted in high— or low—voltage conditions
for another interval.

Or

indicates an error for those substation
banks whose network was reloaded after
the optimization was run. You need to
remove the bank from the plan and update
the interval settings. If the plan is
published, recall the plan before updating
the settings.
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Field Description

Bank Displays the substation banks that are added
in the selected plan.

Load Forecast (KW) Displays the load forecasted for the
substation bank during the selected interval.

Savings (Watts) Displays the power savings (watts) at each
interval.

Estimated Actions Displays the number of estimated actions to

be taken on the associated devices, to
minimize losses.

Estimated Watts/Action Displays the estimated power savings (watts)
if the suggested actions are implemented.

Number of Devices Displays the number of devices associated
with the substation bank.
The CVR optimization results display the following additional columns:

Table 5.2 CVR Optimization Results at Each Interval

Field Description

Total Demand Reduction (Watts) Displays the reduced demand of power
(watts) at each interval if the suggested
actions are implemented.

Lowest Estimated Nodal Voltage Displays the estimated values for the lowest
recommended voltage.

Note: You can change the order of the columns by selecting a column and dragging it
to the desired location.
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Display 5.1 Graphical View of Optimization Results at Each Interval

Intervals | Summary Schedule ‘

= 08:30PM  » b
Select Status Bank Load Forecast (KW) Estimated Actions Number of Devices Savings (Watts) Estimated Watts / Action
@ SAS 13 Bank #2 2592.83 £y 4 2687.30 895.77
@ Reedy Creek 13 Bank #1 259283 £y 4 2687.30 89577
@ Cary West 13 Bank #1 2912.38 3 4 3577 42 1192.47
@ Sand Dune 12 Bank#1 248616 3 4 242003 806.68
@ SAS 13 Bank #1 2779.47 E) 4 3191.10 1063.70
@ Liberty Ave 13 Bank #1 2992.40 3 4 3822.86 1274.29
— o
Bank
Sand Dune 13 Bank #1
(CANESIa Bank e |
|
SAS 13 Bank #1
SAS 13 Bank #2 Reedy Creek 13 Bank #1
Liberty Ave 13 Bank #1

T
4

Color: Number of Devices - Size: Savings (Watts)

The Intervals category consists of the following tabs:

The Summary tab contains the Interval Summary and Plan Summary sections.
The Interval Summary section displays the optimization results of the selected bank
for an interval. The Plan Summary section displays the summarized results of the
complete optimized plan.

The Device Settings tab displays the devices connected to each substation bank in
a hierarchical tree format that you can expand or collapse. The tab consists of the
name of the substation bank, the associated feeders, the corresponding switching
devices (such as capacitor banks or voltage regulators), and the actions required for
each device to perform well.
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Note: An asterisk (*) indicates that the optimized results of the device are different
from the previous interval.

The Comments tab enables you to add comments to share your analysis about the
optimization results with other users or to make notes to yourself. A plan can have
multiple comments. Each comment becomes a separate comment thread, to which
other users can reply. For more information, see “Add Comments to Plans” on page
39.

Analyze the Optimized Plan Result Summary

Bank/Device Summary

The Bank/Device Summary option displays the summary of the optimization results of
the substation banks and the devices associated with the banks. Expand the required
bank to view the list of devices associated with the bank.

The loss minimization results display the settings required for each device to minimize
losses and to increase the electricity savings of the substation bank. For capacitors, the
action indicates whether you should turn the capacitor on or off. For voltage regulators
and transformers, the values indicate the optimal tap settings required to regulate the
load flow. The CVR results display the optimal voltage levels required for each device to
minimize the electricity demand.
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Display 5.2 Optimization Results

Intervals | Summary Schedule

E (=) BankiDevice Summary () Savings Summary

08:30 FM 10:30 PM
Cary West 13 Bank #1 ﬁ
Cary East 13 Bank #1
E SAS 13 Bank#1 _
= regl *
Fhase ATap: 16 {3.75 %) 16 (0.00 %)
Fhase B Tap: 14 (3.75 %) 14 (0.00 %)
Fhase C Tap: 16 {3.13 %) 16 (0.00 %)
B XFM-1
Fhase A Tap: 0 ]
Fhase B Tap: 0 0
Fhase C Tap: 0 ]
B capl * *
Phase A Oiff on
Phase B: Ot on
Phase C: Oiff on
B cap2 * *
Phase C: Oiff on

For example, in this figure, the optimization results of the ‘SAS 13 Bank #1’ substation
bank display the number of estimated actions (Actions: 3) to be taken on the regulators
(reg 1) and capacitor banks (cap1 and cap2) at each interval.

For the regulator tap settings at the first phase (Phase A Tap), the recommended tap
settings is 16 and the resultant increase in voltage is 3.75% in the 8:30 P.M. interval.
The 10:30 P.M. interval does not recommend any changes to the regulator settings,
so there is no change in voltage from the previous setting (0.00%).
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For the capacitor settings at all phases, the recommended action is to turn off the
capacitor in the 8:30 P.M. interval and to turn it on in the 10:30 P.M. interval.

To print the optimized result summary, click =

Savings Summary

The Savings Summary option displays the average savings at each interval if the
suggested actions are implemented. Expand the required bank to view the savings for
the actions.

For loss minimization optimization results, the average power savings are displayed.

Display 5.3 Loss Minimization Savings Summary

Intervals | Summary Schedule
5 () BankiDevice Summary (=) Savings Summary
08:30 PM 10:30 PR
B Interval W Summary _—
Total Actions 13 &
Average Wiaction 1285.55 813273
B Cary West 13 Bank #1 3577.41 16416.50
Total Actions 3 2
Average Wiaction 1192.47 8208.25
B Cary East 13 Bank #1 6120.78
Total Actions 4
Average Wiaction 1530.19

For example, in this figure, the summary results of the ‘Cary West 13 Bank #1’
substation bank display a total of 3 actions that would result in a savings of 3577.41
watts at the 8:30 P.M. interval. The 10:30 P.M. interval recommends 2 actions that
would result in an additional savings of 16416.50 watts.
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Display 5.4 CVR Savings Summary

Intervals | Summary Schedule

E () BankiDevice Summary (=) Savings Summary

B Interval W Summary
Total Actions
Average Wiaction

E Reedy Creek 13 Bank #1
Total Actions
Average Wiaction

B SAS 13 Bank #2
Total Actions

Average Wiaction

08:30 PM 09:30 PM
BT
19 4 |

27419.91 128546.10

74485.07 73407.63

3 1

24828.35 73407.63

74485.07 73407.63

3 1

24828.35 73407.63

For CVR optimization results, the average power reduction at each interval is displayed.
For example, in this figure, the summary results of the ‘SAS 13 Bank #2’ substation
bank display a total of 3 actions that would result in a power reduction of 74485.07 watts
at the 8:30 P.M. interval. The 10:30 P.M. interval recommends 1 action that would result
in an additional power reduction of 73407.63 watts.

To print the optimized result summary, click =

Working with the Analysis Workspace

Select a Plan for Analysis

To view the optimization results of the substation banks added in the plan:

1 In the Analysis workspace, the Open window displays the plans.
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Expand the required plan to view the optimization schedules of that plan.
Alternatively, you can also enter the plan name in the Search field to search the
plan.

Select a schedule date for the plan whose optimization results you want to view and
analyze.

Click OK. The Intervals screen appears by default, and a grid containing the
substation banks of that plan is displayed.

To select a plan at a later time, select File » Open Plan.

Add Comments to Plans

To add a comment:

1

Click the Intervals tab. The optimization results of the substation banks at each
interval are displayed.

Click the Comments tab to start adding your comments.
Enter a title for the comment in the Enter a topic name field.
Enter your comment in the Enter a comment field.
(Optional) Click [ to attach files.

Click Post. The comment is displayed across all intervals of the plan.

Note: To update your comments, click Edit. To search an existing comment, use
the Search within comments field.

Update the Optimized Plan Results

To edit the optimization results:

Note: The £ icon indicates that the plan cannot be updated because it is being used
by another user.
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1 From the Intervals tab, select the banks whose results you want to display in the
Operations workspace. The &% icon is enabled.

2 Click &5 to update the interval for the plan. A progress bar indicates that the update
process is in progress.

Note: For loss minimization, when an interval is updated, it might produce an error
while forecasting the load for future intervals. An error & is indicated and the bank
cannot be included in that interval. To clear the error, change the selection of the
bank in the previous interval and click &%. If the error is still displayed, you need to
remove the bank from the plan.

Publish the Optimization Plan Results

To publish a plan to the operator for implementation:

1 Select a plan to view the optimized plan results. You can view the plan results at
each interval or as a summary.

2 From the Intervals tab, process through each interval, and then select the banks
whose results you want to display in the Operations workspace.

3 Click &% whenever you want to update any interval of the plan.

4 In the last interval of the plan, click £ to publish the results in the Operations
workspace. A progress bar indicates that the publish process is in progress.

Note: The H icon is enabled only after you select the last interval of the plan while
you are updating it.

After a plan is published, the  icon changes to . If you want to change the optimized
results, click 3 to recall the plan in the Analysis workspace.

Note: If the network associated with a published plan is updated, you need to recall the
plan before creating a new plan with the updated results. This ensures the accuracy of
the optimization results in the Operations and Reporting workspace.
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Viewing the Optimized Plan Results
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About Optimization Results

The forecasted optimization results help an operator understand the actions to take to
minimize electric losses and reduce demand for power. These results of the optimized
plan are displayed in the Operations workspace after the plan is published by the grid
engineer from the Analysis workspace.

The Operations workspace consists of the Intervals tab and the Summary Schedule
tab. You need to select a plan first before you can view its optimization results.

Working with the Operations Workspace

Select a Plan

To view the optimization results of the substation banks added in the plan:
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1 In the Operations workspace, the Open window displays the plans.

2 Expand the required plan to view the optimization schedules of that plan.
Alternatively, you can also enter the plan name in the Search field to search the
plan.

3 Select a schedule date for the plan whose optimization results you want to view and
analyze.

4 Click OK. The Intervals screen appears by default, and a grid containing the
substation banks of that plan is displayed.

To select a plan at a later time, select File » Open Plan.

View Results at Each Interval

The Intervals tab displays the settings required for the devices associated with the
substation banks at each interval. The values contain the optimal voltage settings for
voltage regulators and transformers and the recommended actions for capacitors.

Select an interval from the drop-down list. The optimization results of the substation
banks in that interval are displayed as follows:

Table 6.1 Interval Results

Field Description
Bank Displays the substation banks that are added in the selected plan.
Device Displays the settings required for the device.

For capacitors, the action indicates whether you should switch the
capacitor on or off. For voltage regulators and transformers, the
values indicate the optimal tap settings required to regulate the
load flow.
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Display 6.1 Results at Each Interval

Intervals | Summary Schedule |

B (08:30PM | ¥

Bank Device Device Device Device Device Device
regi* regz® reg3® regd* capi cap2
N 123 E ---

regi* reg2* reg3® regd* capl cap2

- 123 B ---

This figure displays the recommended device settings for the substation banks at the
8:30 P.M. interval. The new tap settings for all four regulators are indicated by the
asterisks. In the ‘James 123 Bank #1’ substation bank, the new regulator tap setting for
reg 1 is -7 and the voltage drop percentage is (-8.75%). There are no changes
recommended in the settings for the two capacitor banks, so they remain the same.

To print the optimized results at each interval, click =
The Intervals category consists of the following tabs:

" The Device Settings tab displays the devices connected to each substation bank in
a hierarchical tree format that you can expand or collapse. The tab consists of the
name of the substation bank, the associated feeders, the corresponding switching
devices (such as capacitor banks or voltage regulators), and the actions required for
each device to perform well.

Note: An asterisk (*) indicates that the optimized results of the device are different
from the previous interval.

"  The Comments tab enables you to add comments to share your analysis about the
optimization results with other users or to make notes to yourself. A plan can have
multiple comments. Each comment becomes a separate comment thread, to which
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other users can reply. For more information, see “Add Comments to Plans” on page
39.

View the Summary of Results

The Summary Schedule tab displays the summary of the optimized substation banks,
their associated devices, and the recommended actions to take to minimize losses. In
addition, a savings summary forecasts information about the average amount of power
that the utility can save if the recommended actions are followed. For more information,
see “Analyze the Optimized Plan Result Summary” on page 35.

The Plan Summary pane displays the summarized results of the complete optimized
plan. The summary consists of the total number of banks and associated devices in the
plan and the average values of the power savings.
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Overview of Reports

SAS Energy Distribution Optimization displays the optimization results using interactive
graphs in the dashboard. These graphs help the utility to monitor the electric load
requirement and the consumption of a substation bank. You can compare the
optimization results across all the electric substation banks under that utility and
understand the savings or demand reduction in the substation banks when the results
are implemented.

SAS Energy Distribution Optimization uses SAS Visual Analytics to display the graphs
for the loss minimization and conservation voltage reduction (CVR) optimization results.
You can select the day or date range to generate the reports of the optimized plans that
are published during the selected period. The graphical reports are generated as a time
graph or a bar chart. You can also view these reports in a PDF format.
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The following figure describes an example of a bar chart report for one of the CVR
optimization results. The blue bar displays the SAS Energy Distribution Optimization
suggested optimization results for reducing demand, and the green bar displays the
actual results of the reduced demand during the selected period.



Overview of Reports

Display 7.1 Sample Report

CVR for March
Potential KW Demand Reduction f Actual KW Demand Reduction

4000 — - - - - - - - - - - - - - -------------------
Date: 21-Mar-2014
Actual KW Demand Reduction: 3615586
3000 —+----
2000 —+----
1000 +----
0

21-Mar-2014
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Type of Reports

SAS Energy Distribution Optimization provides the following type of time graph and bar
chart reports:

CVR Demand Reduction for Period
Displays the comparison between the optimized and actual results of the reduced
demand during the selected period.

CVR Demand Reduction for Day
Displays the comparison between the optimized and actual results of the reduced
demand during the selected day.

Loss Minimization Reduction for Period
Displays the comparison between the optimized and actual results of the electricity
saved during the selected period.

Loss Minimization Reduction for Day
Displays the comparison between the optimized and actual results of the electricity
saved during the selected day.

Power Factor for Period
Displays the comparison between the initial power factor at the start of each interval
and the results of the power factor after optimization.

Power Factor for Day
Displays the comparison between the initial power factor at the start of each day and
the results of the power factor after optimization.

Note: The reports are displayed based on the time zone of the server. If the server and
browser are located in different time zones, the data is displayed based on the server’'s
locale.
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About the Reporting Workspace

The Reporting workspace enables you to generate reports of the loss minimization and
CVR results. The workspace consists of the toolbar, a workspace area to display the
reports, and options to select the predefined reports and create customized reports
according to your preferences.

Here are the toolbar options that are available in the Reporting workspace:

Table 7.1 Toolbar Icons

Toolbar Icons Action Description

L Back Navigates to the location of the last
browsed folder.

Up Navigates to a level above the current
folder location.

%) Refresh Reloads the items in the grid.
m Delete Deletes the item that is selected in the
grid.

Note: Only a user with the
administrator role can delete
optimization reports.

[ ] New Folder Creates a new folder in which you can
create your reports.

Views The Details view displays the Name,
Type, and Date Modified columns of
the report.

The List view displays only the name
of the report.
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Toolbar Icons Action Description

JCl Search Opens the Search window, in which
you can search for reports that
contain a specific text string.

Working with the Reporting Workspace

Create a Report

You can define the type and format of the graph report. To create a report:

1 Select File » New or select New in the Open window. The Create Report window
appears.

2 Click Browse to select a folder location for your report. The Choose a Location
window appears.

a You can select an existing folder location, or click i to create a folder. The
location appears in the Selected Location field.

b Click OK. The folder location is displayed in the Location field of the Create
Report window.

Note: The OK button is disabled if you do not have permissions to the selected
folder.

3 Enter a unique name for the report in the Name field. The name of a report is limited
to 60 characters and cannot containthe ! % * . & =\/|'; > and < characters.

Note: If the name is duplicated, an error is displayed while creating the report.

4 Enter a description for the report in the Description field. The description of a report
is limited to 60 characters and cannot containthe ! % * . & =\/|"';>and <
characters.
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5 Select the type of report in the Type drop-down list.

CVR Demand Reduction for Period to view the optimized and actual results of
the reduced demand during the selected time.

CVR Demand Reduction for Day to view the optimized and actual results of the
reduced demand during the selected day.

Loss Minimization Reduction for Period to view the optimized and actual
results of the electricity saved during the selected time.

Loss Minimization Reduction for Day to view the optimized and actual results
of the electricity saved during the selected day.

Power Factor for Period to view the initial power factor at the start of each
interval and the results of the power factor after optimization.

Power Factor for Day to view the initial power factor at the start of each day and
the results of the power factor after optimization.

6 Select the graph format as a Time Graph or Bar Chart from the Format drop-down
list.

7 Select the Start date and End date of the optimization schedule in which you
require the report results to be generated.

Note: If there are no optimized plans available in the selected date range, the report
results appear blank.

8 Click OK. A progress bar indicates that the report creation process is in progress.

The optimization results are displayed in the selected graph format.

Note: Sometimes, loss minimization reports might display negative savings. Contact
you network administrator for assistance.

View Reports

To view the predefined reports for comparing the results of the substation banks before
and after the optimization process:
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1 Select File » Open. The Open window appears.

2 Select the report to view and click OK. The reports are displayed in the Time Graph
or Bar Chart graph format.

Note: The reports are displayed based on the time zone of the server. If the server and
browser are located in different time zones, the data is displayed based on the server’'s
locale.

You can also view the reports in a PDF format:
1 Select File » Print PDF. The Print (pre-production) window appears.

2 Select the orientation type, paper size, options, and margins to set the display of the
PDF report.

3 Click Print. The report is displayed in the PDF format.

The PDF preferences are displayed at the bottom of the page when you position
your cursor over the PDF. You can use these options to save and print the PDF
report.

Note: Ensure that SAS Visual Analytics server (SaSserver12) is active while you
are creating reports in PDF.
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